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PHILOSOPHY OF VALLEY ELEMENTARY SCHOOL

Believing education to be both the basis for and the unifying force in a democratic society, the faculty and staff of Valley Elementary School seek to develop each student to his/her fullest potential.  Hopefully, this will enable him/her to become a contributing member of society.  To this end we strive to instill in each individual respect, self-discipline, responsibility, appreciation of the aesthetic, and critical thinking. 

The faculty and staff of Valley Elementary School also seek to provide a learning environment that enables a student to perform academic skills in accordance with his/her ability; develop habits conducive to sound health, safe living and mental well-being; discover the joy of learning through understanding, caring, and patient teachers.

In a rapidly developing society, change is inevitable. New teaching techniques and instructional methods are steadily coming to light.  The faculty and staff of Valley Elementary School commit ourselves to the re-evaluation and modification of teaching techniques and instructional methods to take into account these changes. 
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Valley Elementary School will provide all children with opportunities to develop their potential in a secure, nurturing, and stimulating environment, through the cooperative efforts of staff, parents, and the community.

OBJECTIVES FOR VALLEY ELEMENTARY SCHOOL 

1. Create a classroom environment in which each child can reach his/her potential and experience some degree of success in the learning process.

2. Develop communication skills that enable the individual to share ideas with his/her peers as well as adults.

3. Provide opportunity for children to assume responsibility for learning through activities such as planning, executing and evaluating individual and group work within the classroom.

4. Enable the individual to master the life-skills needed to live successfully in a changing environment.

5. Encourage critical thinking so that each student can make intelligent decisions in regard to environmental, social, political and cultural issues.

6. Arouse in each student an appreciation for his/her heritage, a sense of patriotism, and a respect for the natural world.

7. Provide the structure for assertive discipline through which each individual can assume responsibility for his/her behavior at school.
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1. ANNOUNCEMENTS

The school day will begin with the Pledge of Allegiance, the ROAR Pledge, the Moment of Silence and any necessary announcements.

2. ASSEMBLIES

A student's behavior at assemblies should be refined and courteous.  Whether guests are present or not, each student is responsible for the impression made by the school as a whole. Unacceptable assembly conduct includes whistling, uncalled-for-clapping, boisterousness, and talking during a program.  Unacceptable behavior during an assembly could result in the child’s removal from the assembly.

3. ATTENDANCE 

Regular school attendance is necessary for students to receive the full benefit of public education.  In addition, state compulsory attendance laws mandate school attendance until the age of eighteen.  As such, all parents and students must accept responsibility for regular student attendance in school.

When a student is absent from school, parents or guardians should call the school to report the student’s absence by 10:00 am.  If no telephone is available, then upon the student’s return to school, the parent or guardian must send a written note stating the reason for the student’s absence.  Parents or guardians will be notified by telephone whenever a student does not attend school and the school is not aware of the reason for the absence. 

All absences other than those listed below as unexcused shall be considered ‘excused’ if oral or written communication is received from the parent or guardian within two school days.  Three types of absences are considered unexcused:

1. No oral or written communication regarding a student’s absence is received from the parent or guardian within two school days
2. Skipping School 
3. Out of school suspension

The following reasons given for excused absences will not affect a student’s ability to earn course credit.

1.   Medical/dental appointments or personal illness (medical documentation required)
2.   Illness, death, or funeral in the family limited to parents, siblings, aunts, uncles, and grandparents
3.   Students sent home by the school nurse
4.   Recognized religious holidays
5.   Lawyer/court official meeting (court documentation required)
6.   School-sponsored activities
7.   Pre-arranged absences with prior approval of the building administrator  

Attendance letters will be sent home to parents or guardians notifying them when a student has been absent a total of five and ten days during a school year.  Upon accumulation of fifteen days of school absences, the principal will send a summary of absences and reasons given for the absences to the superintendent.  Juvenile court officials will be notified of excessive student absences; court intervention will be sought after other strategies have proven ineffective.
A daily record will be maintained for tardiness and early dismissals, noting the time and reason given by the parent/guardian. Parents or guardians will be notified in writing when tardiness and early dismissals become excessive.  Three tardy and/or early dismissals equal one absence.

Our goal is to improve student attendance for the 2024 – 2025 school year.  All students that were chronically absent last year will be closely monitored during the 2024 – 2025 school year.  Any student that reaches the chronically absent threshold at the end of any grading period will be removed from good school standing and will be required to attend after school tutoring to recover lost learning.

Each grading period is approximately 45 days (about 1 and a half months) so any student exceeding 4 absences in a grading period will reach the chronically absent threshold.  In addition, students that are chronically absent during the school year may not be allowed to participate in extracurricular activities.  If during the 4th quarter a student’s absences exceed 17, they will be removed from good school standing and taken to recover lost learning.
      
Good attendance is crucial to a student’s academic success, personal development, and future opportunities.  It promotes a holistic educational experience that benefits students in multiple aspects of their lives.  Let us work 
together to help your child achieve excellence.

Makeup work for absences will be due three days after the student returns to school (Example: If a student is absent on Monday, and returns on Tuesday, then makeup work is due on Friday).  For absences of more than one day, students will be given an extra day (up to a maximum of five days) to complete makeup work for each additional day of absence.  The building administrator may make exceptions for extenuating circumstances (Example:  hospitalization).

The following is used to define perfect and outstanding attendance.

Perfect Attendance*
Attending school all day constitutes perfect attendance.  This includes no absences, no tardiness, and no daily early departures during the school year.

Outstanding Attendance*
Students that miss three or less days during the school year have outstanding attendance.  This may include full days missed and/or tardiness or early departures.

See BCPS policy JED and JED-R for more information.

4. BUS PASSES
	
If a student wishes to go home with another student, both students must bring permission slips from home stating that such action is permissible with both sets of parents.  Notes should contain date, name, phone number of parent/guardian granting such permission, and the address of the home your child will be going to.  Passes to ride another bus or to get off at a stop other than the student’s designated stop must be obtained from the office.  Any student who does not obtain the pass will be denied permission to ride another bus, nor will he/she be allowed to get off the bus at any stop other than his/her own stop.  If it is necessary for a student to ride another bus periodically throughout the year, parents should write “for the year” on the initial request.  

5. CAFETERIA
              
Bath County Public Schools offer meals that meet the USDA Dietary Guidelines for Americans.   Students are encouraged to enjoy nutritious school meals that support learning and academic success.   All children eat in the cafeteria.  Student behavior at meals should be based on courtesy, good table manners, and cleanliness.
Meals at No Charge for Enrolled Students
Through the CEP program all students will receive breakfast and lunch at no charge.
 
Extras/A la Carte
       Extras and a la carte items must be purchased by adding funds to your child’s account through My School Bucks. 
       Extras or a la carte items may not be charged.  (Policy JHCH)
 
Payment for Extras or A la Carte
       Meals will be provided at no charge to enrolled students; however, fees apply for extras and a la carte purchases.
       Extras or a la carte items may not be charged.  (Policy JHCH)
       Money may be added to student accounts by “Cash Only” on every Monday or go through My School Bucks. Contact the school office if you need assistance with My School Bucks. Upload funds through https://www.myschoolbucks.com



	MySchoolBucks
Pay for school meals and fees securely online! With MySchoolBucks, parents can also view cafeteria purchases, access meal balances, register for activities, purchase event tickets, browse school items, and more.
www.myschoolbucks.com


 
Adult Prices
Breakfast   $2.75
Lunch         $4.65

CAFETERIA RULES
 
     Sit at assigned table(s) and remain seated until finished eating, except to get a drink of water.
     Make one trip to return tray and/or dispose of trash.
     Discard recyclable materials in the container provided.
     Enjoy talking with your friends at a conversational level – NO loud talking or shouting.
     Soft drinks and energy drinks in cans or bottles are NOT allowed.
     Selling or trading food or drink to/with other students is NOT allowed.
     Follow the directions of all school staff.
     Food must be eaten in the cafeteria.  Students are not allowed to take trays to the classroom to eat.
     Students may have water with his/her meal.  Cups are provided.
   No gum is permitted in school.
 
The parent or guardian of a student with an allergy and/or special dietary needs, must annually submit the form “Physicians Statement for Students with Special Dietary Needs”.  This form is available through the main office and must be returned to the cafeteria manager in order for changes to be made to the foods served to that student.  The doctor needs to list the substitutions that are to be used for the student.  Should a student have a milk allergy, juice may not be served as a substitute, lactose-free milk will be offered in place of milk.
 
      
BREAKFAST AND LUNCH

All students may receive a no-cost breakfast and lunch. Bath County Schools offer meals that meet the Dietary Guidelines for Americans set by the United States Department of Agriculture.

For breakfast there are three required food items offered daily:  grain, milk, fruit or vegetable.  Usually two grains are offered, but sometimes there will be one grain and one meat item offered at Breakfast.  One cup of fruit or vegetables are served at breakfast, only one-half cup may be juice.  At least one-half cup must be taken to count as a reimbursable meal.

NOTE:  Breakfast is not served on days when school opening is delayed.  Lunch begins soon after arrival at school.

If your child/children do not eat breakfast at home, please encourage him/them to eat breakfast at school.  Studies have shown that students who eat breakfast concentrate and perform better in school.

For lunch, students must be offered five required items.  Food items offered include meat, dairy, grain, fruit, and vegetable.  

Grades 2-7 are given the option of “Offer vs. Serve” (OVS).  It is designed to cut back on food waste.  
Students in grades 2-5 may decline one item.  Students in grades 6 and 7 may decline two items.  All grades must be served at least one-half cup of a fruit or vegetable to be considered a meal.

The cafeteria staff will help students understand what will count as a full meal.  It is our goal to serve the students nutritious reimbursable meals in hopes of the student performing to his/her full potential in the classroom.  Please encourage your son/daughter to ask questions while going through the line.


6. CALENDARS

The 2024-2025 division calendar is printed on the inside front cover of this handbook.  Monthly school calendars will be available on the Bath County Public Schools web page (https://www.bath.k12.va.us), and monthly school calendars will be distributed.  Calendars are subject to change due to inclement weather days.


7. CHEATING 

Cheating is not acceptable conduct.  A student suspected of or caught cheating will be confronted immediately, privately if possible.  The student will be allowed to complete the assignment, but the teacher will conduct an investigation and, if necessary, refer the situation to the principal.  

8. CHECKS

Any person passes any check or draft, for payment to the school, which is subsequently returned for insufficient funds or because there is no account or the account has been closed, shall pay to the school a fee, in the amount of twenty dollars ($20.00), in addition to the amount of such check or draft.

9. DIGITAL DEVICE REGULATION (cellular phones, mp3 players, iPods, iPads, Tablets etc.)

BCPS regulation JFC-R: Possession of cellular telephones, or similar devices: Students may possess a cellular telephone, or other communications device, mp3 player, iPod, iPad, or other Tablet on school property, including school buses, provided that the device must remain off and out of sight during the instructional day.  If a student possesses such a device other than as permitted in this policy, in addition to other disciplinary sanctions which may be imposed, the device may be confiscated from the student and returned only to the student’s parent.

Bath County Public Schools recognizes parental concern about student safety while traveling to and from school and events and while at school. Therefore, BCPS will allow students to possess digital devices (including any electronic recording, play-back or storage device) provided the following rules are strictly adhered to:

1) Bath County Public Schools faculty or staff members will not be held responsible at any time for any form of loss, theft, and/or damage to any digital device that is brought to school.

2) Digital devices must be TURNED OFF upon entering the school building and can be turned back on upon leaving the building.  

3) Digital devices are to be turned off and placed in lockers. Those not placed in a secure location and turned off
       will be confiscated if seen or heard.

4) Students are expected to report to the office to make any outgoing calls.

5) Parents are expected to call the school to contact their children. 

6) At no time should a student ask a bus driver to speak to a parent or guardian on a cellular phone. ALL changes in bus transportation MUST be routed through the main office so that proper bus passes and documentation can occur.  Should an unfortunate event occur, it is imperative that the school have accurate information as to the whereabouts of each student.








7) Violation of this policy will result in the following consequences:

a. Digital devices will be confiscated and brought to the office. Parent/Guardian notified to pick up device the following day.

b. Refusal to relinquish device:
A student may be asked by any staff member to relinquish their digital device.  Failure to do so will be viewed as defiance and referred to the office. The principal then reserves the right to confiscate the device and assign 1-3 days of ISS for defiance.

8) The above consequences will apply regardless of to whom the digital device belongs.  In other words, student A borrows student B’s phone and is in violation of the policy. Student B’s phone is confiscated. 

10. DISCIPLINE and SCHOOL RULES

Our goal in discipline and conduct is to provide Valley Elementary a positive and safe place to learn.  However, we are also aware that discipline concerns will come up each day.  Some of those concerns can be easily handled in the classroom by the teacher.  Each teacher will have a written plan that communicates to the students and to parents the expectations and consequences in classroom behavior.  This plan will also be on file in the office. 

A character development program is also in effect to recognize students modeling positive character traits.  Each month a different trait is featured and the school counselor, as classroom teacher, works with the trait during lessons and other activities to point out the actions of someone with this trait.  

Everyday concerns will be taken care of through the teacher in working with the student and/or talking with parents before bringing that concern to the principal.  When the student is sent to the office, he/she will come with a referral to the office that describes what has been done to work with the student in the past or what has brought this to an office referral.  

Certain violations of the school Standards of Conduct warrant a direct office referral without working with the student to solve the situation in other ways.  The following are those referrals that can have students sent to the office without going through the entire classroom plan:

1. Dress code violations - Result in the parents being contacted by the principal to bring appropriate clothing and
the student will be placed in ISS until proper clothing is received.
2. Profane, Obscene or Abusive Language
3. Threats or intimidation
4. Fighting
5. Any drug, including vape, or alcohol possession
6. Possession or use of a weapon
7. Unacceptable use of the Internet
8. Vandalism 

A committee of teachers and staff members from both elementary schools worked collaboratively to create a matrix of school expectations.  (See appendix A.)  This committee also created a school wide reward system which includes three levels of rewards for students to recognize their positive behavior.  More information will come home with students in the first week of school.

11. DRESS CODE

The administration maintains the right to demand that clothing be appropriate and not distract from the learning environment. Students should consider school as a place of business where they are learning both academic and social skills. Therefore, they are expected to wear attire appropriate for business/school day activities. The following are specific regulations governing this area:

•	Hats, headgear, and dark glasses will not be worn or carried inside the school building.  Hooded sweatshirts are acceptable. However, hoods may not be worn in the building during the school day.

· All shorts, dresses, and skirts, etc. must fit appropriately and must extend below the longest finger on either hand when both arms and hands are fully extended at the student's side. Due to the physical characteristics of certain students, any exceptions to this rule must be approved by the parent and the school administration.

· All appropriate undergarments must be worn and completely covered at all times.  Undergarments should not be visible through shirts or tops.  Students may not wear pajamas to school.

· Students may not bring blankets to school.

· Shirts/blouses altered or enlarged at the waist, neck, or under arms, are not appropriate attire. Shirts/blouses must fit appropriately, and the midriff must be covered at all times.  No off the shoulder shirts.

· Spaghetti strap shirts or dresses are not allowed.

· No excess cleavage should be revealed. Shirts must pass the “fingertip test”. (Thumbs should be placed at the arm pit and hands extended straight across the chest parallel to the floor. If the shirt is below the fingers, then it is too low.)

· Shoes must be worn at all times, and shoes designed to be tied are to be tied.  Hunting boots are not allowed.  Flip flops are not permitted due to safety concerns.

· Lewd or suggestive clothing may not be worn (Example: “Big Johnson” tee shirts).  Clothing or jewelry that advertises, glorifies, or symbolizes any illegal substance, including tobacco and/or alcohol products, should not be worn.  Also, “Confederate” logo shirts will not be permitted.

· Pants must be worn around the waist as designed.  Sagging pants and shorts hanging on hips are forbidden.  Any pants worn low enough to expose boxers or underpants, even when covered with a shirt, are unacceptable.

No rule or regulation can adequately address changes in style or other inappropriate wearing of apparel. The principal will utilize their discretion in dealing with circumstances not specifically addressed in this handbook.

12. DRILLS

Drills and procedures will be discussed with students during the first week of school.  

Fire drills are held each week during the first month of school and monthly, at irregular intervals, throughout the remainder of the school year.  Exit routes are posted in each classroom.  In the event of fire or other emergency, rules for leaving the building are as follows:

· Walk without talking.
· Move quickly and quietly to the designated area.
· Quietly remain in the designated area until the area leader releases you back into the building.

School bus drivers will conduct evacuation drills throughout the school year.

Tornado and lock down drills will be held each semester.


13. DRUGS, ALCOHOL, and TOBACCO 

Valley Elementary School is a Drug Free School.  Smoking, chewing or any other use of any tobacco products by staff, students, and visitors is prohibited on school property.  Please see the “Tobacco-Free School for Staff and Students” in the policy manual.  (Policy GBEC)

Health instruction (K-7) will include drug, tobacco and alcohol prevention instruction.  (Policy GBEC)


14. EARLY ARRIVAL AT SCHOOL

Students should not arrive at school before 8:00 AM.  All students should report to the cafeteria.  All students will be released to their homerooms at 8:15. Preschool students will be met at the entrance to the school and escorted to their classroom.      


15. EMERGENCY CARE FORM

At Open House or on the first day of school, each student will be given an online emergency care form to be completed annually by a parent or guardian.  The form should be completed online.  Parents or guardians should notify the school if any information changes during the school year.

16. EMERGENCY SCHOOL CLOSINGS

BCPS uses the School Messenger System in case of inclement weather and emergency closings.  See the division wide handbook for more information.

17. ENTRANCE REQUIREMENTS 

Before being admitted to a public school for the first time, a student must provide documentation of a complete physical examination within one calendar year prior to entrance.  Beginning July 1, 1992, form MCH 213-C must be used.  The State Health Department provides this form to local health departments, private physicians, private schools, and day care centers.  The form is also distributed at kindergarten registration.

Upon entry or transfer, documentary proof shall be provided of adequate immunization with the prescribed number of doses of vaccine indicated, as appropriate for the child’s age:

DTP, TdaP, DT, or Td - A minimum of 4 properly spaced doses.  A child must have at least one dose of DTaP or DTP vaccine on or after the fourth birthday. DT (Diphtheria, Tetanus) vaccine is required for children who are medically exempt from the pertussis-containing vaccine (DTaP or DTP).  Adult Td is required for children 7 years of age and older who do not meet the minimum requirements for tetanus and diphtheria.  Effective A booster dose of the Tdap vaccine is required for all children entering the 7th grade.

Polio (IPV) – A minimum of 4 doses.  One dose must be administered on or after the fourth birthday.

Hib (Haemophilus Influenzae Type b) - Required only for children up to 60 months of age.

Hepatitis B – A complete series of 3 properly spaced doses of hepatitis B vaccine are required for all children.  

Measles (Minimum of 2 doses), Mumps (2 doses), Rubella (1 dose) – Most children receive 2 doses of each because the vaccine is usually given as MMR).

Varicella (Chickenpox) – All children born on and after January 1, 1997, shall be required to have a dose of chickenpox vaccine at age 12 months or older. Effective March 3, 2010, a second dose must be administered prior to entering kindergarten but can be administered at any time after the minimum interval between dose 1 and dose 2.

Hepatitis A (HAV) – Effective July 1, 2021, a minimum of 2 doses of Hepatitis A vaccine.  The first dose should be administered at age 12 months or older.

Human Papillomavirus (HPV) – Effective July 1, 2021, a complete series of 2 doses of HPV is highly recommended for students entering the 7th grade.  The parent or guardian after reviewing educational materials approved by the Board of Health, at the parent’s or guardian’s sole discretion, may elect for the child not to receive the HPV vaccine.

Meningococcal Conjugate (MenACWY) – Effective July 1, 2021, a minimum of 2 doses of MenACWY vaccine.  The first dose should be administered prior to entering the 7th grade.  The final dose should be administered prior to entering the 12th grade.

An original birth certificate and social security number must be presented at initial school registration.  

18. FIELD TRIPS 

Field trips offer opportunities to extend learning opportunities for students, and it should be noted that field trips are a privilege offered to students that exhibit proper conduct in the classroom, in the school building and while riding the school bus.  No student will be denied participation in a field trip because of the expense of the trip.  

When field trips are planned, students who continually violate the school discipline plan, up to the time of the field trip, could be denied the opportunity for the trip.  A student receiving a principal approved office referral within three weeks of a field trip will not be allowed to participate in the field trip.  Academic difficulties (e.g., incomplete assignments) could also be a cause for denial of field trip opportunities. If a student misses a field trip, he or she could be required to do an alternative assignment of the teacher’s choice.  

Parents are encouraged to serve as field trip chaperones.  Chaperones must ride the school bus.  Parents that volunteer to go on field trips may not bring other children with them.  Teachers and the principal will select chaperones from the list of approved volunteers.  Chaperones must complete the necessary forms in order to chaperone.  Forms are available online or in the main office.



19. FUNDRAISING

Fundraising activities involving students must be approved at both school and division levels.  Door-to-door sales by students are not allowed.  Students may not participate at school in a fundraiser that is not directly related to the school.

20. GRADING and REPORT CARDS

The evaluation of student achievement is an important teacher responsibility.  The following grading system is in effect:

	

Kindergarten and Grade 1:
	S		Satisfactory
W		Working On
N		Needs Improvement
Blank          Skill Has Not Been Introduced

Grades 2 – 7:
90-100		A       Excellent
80-89		B       Above Average
70-79		C       Average
60-69		D       Passing
Below 60		F       Failing

Art, Band, Music and Grade 2 History and Science:
E  	Excellent
S  	Satisfactory
	N 	Needs Improvement
	U 	Unsatisfactory


*An Incomplete is given only in cases due to illness or emergency where the student is unable to complete assignments. An Incomplete on the report card becomes an "F" if work is not completed within an agreed upon time.  Make-up work is the responsibility of the student.
               
Report cards will be issued four (4) times each school year, at the end of each 9-week term, and progress reports (for all students) will be sent home at the midpoint of each term.  Parents or guardians should sign report cards and progress reports, as requested, and return them to school within three days.

Two parent-teacher conference days will be scheduled during the 2024-2025 school year, at the end of term 1 and the end of term 3.  In addition to conferences scheduled on these days, a parent-teacher conference to discuss student progress can be scheduled at any time at the request of either party.

Pupils who fail two consecutive nine weeks will be referred to the Child Study Team. 

Grade promotion requires an annual 70% achievement of curriculum objectives.  Grade placement may be allowed for pupils who do not achieve 70% on non-basic subjects; however, retention will be automatic for those failing a course for the second year.  Failure by students "placed" in a grade to achieve 70% achievement will result in automatic retention the following year.

To promote communication between school and home and to encourage organizational skills, homework planners and folders will be provided to all students in grades 2-7 (planners) and K-7 (folders).   Additional or replacement homework planners ($1.50) or folders ($1.00) may be purchased in the school office.

Grades are available online for parents of students in grades 2 through 7.  At the beginning of the year, you will receive log-in information specific to your child.  


21. GUIDANCE and COUNSELING PROGRAM 

The Bath County School Board affirms that parents are the student's first teachers and that the public schools should serve to strengthen family and parental support.  No student will be required to participate in any counseling program to which the student's parents object.

For the purposes of this policy, the following definitions apply:

a)	Academic Guidance - Guidance which assists students and their parents to acquire knowledge of the curricular choices available to students, to plan a program of studies, to arrange and interpret academic testing, and to seek post-secondary opportunities.

b)	Career Guidance - Guidance which helps students to acquire information and plan action about work, jobs, apprenticeships, and post-secondary educational and career opportunities; and

c)	Personal/Social Counseling - Counseling which assists a student to develop an understanding of themselves, the rights and needs of others, how to resolve conflict and to define individual goals, reflecting their interests, abilities, and aptitudes.  Such counseling may be provided either (1) in groups in which generic issues of social development are addressed or (2) through structured individual or small group multi-session counseling which focuses on the specific concerns of the participant(s).

At least annually, parents will be notified in writing about the academic and career guidance programs, and the personal/social counseling programs which are available to students within the school division.  Parents will be advised concerning the purpose, general description of the programs, how parents may review materials to be used in the programs, and procedures by which parents may limit the student's participation in the program. Information and records of personal/social counseling will be kept confidential and separate and not disclosed to third parties without parental consent or as otherwise provided by law.

It is the policy of the Bath County School Board with respect to personal/social counseling that parents may "Opt-Out" by notifying the school division in writing if a student is not to participate in the personal/social counseling program.

Counseling techniques that are beyond the scope of the professional certification or training of counselors, including hypnosis, or other psychotherapeutic techniques that are normally employed in medical or clinical settings and focus on mental illness or psychopathology are prohibited.  See BCPS policy IJ for more information.

22. HALLS AND RESTROOMS 

A student should be in the hall only at the beginning and close of school and while moving from one class to another unless he/she has staff permission or a special duty that requires him to be there.  Students are expected to be courteous at all times, considerate of students and teachers in classrooms, and to keep to the right when moving in the halls.  Running and shouting in the halls are unacceptable.

Restroom breaks will be included in class schedules.  Students are expected to travel directly to and from the restrooms.  No horseplay or misuse of facilities will be tolerated.

23. HEALTH SCREENINGS

Health screenings are performed by the school nurse with assistance from the health department nurse.  Vision and hearing screenings will be done on all new, third, and seventh grade students and a scoliosis screening will be done on all sixth graders.  Also, the height and weight of all students is taken at the beginning of each school year by the physical education teacher.

A BMI (Body Mass Index) screening will also be done for 6th and 7th grade students.  This screening is to track the incidence of overweight children so early intervention can possibly reverse the trend leading to adult obesity.  Adult obesity leads to a higher risk for chronic, often fatal illnesses such as diabetes, heart disease, hypertension and stroke. Parents may choose to opt out of the BMI screening for their child(ren). 


24. HOMEWORK

Homework can provide an essential communication link between the school and the home. One measure of a program or course is the quality of the work done at home by the student. A strong home-school partnership, with many lasting benefits for the individual student and his/her family, can be greatly enhanced by a sound program of homework. In addition, homework should be an important tool in developing independent thought, self-direction, and self-discipline. It can assist the student in developing good work habits and in the wise use of time. 


Guidelines for homework include: 

1. Homework should be assigned after introduction and thorough explanation of the skills necessary to successfully complete the assignment. 

2. Homework should be assigned in such a manner that it will be clearly understood by all students. 

3. Homework should serve a valid purpose and be closely related to classroom activities. 

4. A student's access to resource materials should be considered when making assignments. 

5. Homework should be evaluated promptly and returned to the student. Appropriate rewards should be given to those students who successfully complete assigned work. Effort and competency should be recognized and rewarded. 

6. Teachers should seek to determine the cause if a student regularly fails to complete assigned work. Teachers should not avoid giving homework because they believe students will not do the work. 

7. Excessive homework, like the absence of homework, should be avoided. 

8. Homework should not be used for disciplinary purposes. 

9. Teachers and administrators should take appropriate steps to communicate with parents regarding the division's homework policy and to solicit their support.

25. HONOR ROLL (Grades 3-7)

Academic recognition is given through the Honor Roll published at the end of each 9-week grading period.  The Principal's List will recognize students receiving all A's.  The Teachers' List will recognize students receiving all A's and B's.  In addition to grades, a student must have a satisfactory grade in ungraded subjects - physical education, art, music, and band.  

To determine year end honor roll, an average will be taken of all four grading periods.

26. INSURANCE (School Related Accidents)

See the division wide handbook for information.

27. LEARNING OBJECTIVES

Each grade level will provide the learning objectives and/or SOL’s to be taught during the school year.  SOL testing will be conducted at the end of each school year for grades 3 through 7.  See BCPS policy IAA for more information.

28. LEAVING SCHOOL 

A student is not allowed to leave the school building or grounds, except on his regular school bus, without permission from a parent or guardian.  Parents or guardians should report to the school office to sign out a student before taking a student from school.

Any student leaving school grounds (including the school bus) without proper authorization is subject to suspension.  A student who leaves the school building during an after-dark activity will be considered as trespassing.  Parents and/or local law enforcement officers will be notified, as appropriate.

29. LIBRARY SERVICES

The Library Media Center will be open from 8:15 AM to 3:30 PM, Monday, Wednesday and Friday.  Students are encouraged to use the library as much as possible as they become independent readers and researchers. 
 
Preschool – fourth grade students will have scheduled library classes each week.  Instruction will facilitate skills, promote interest in reading, and allow time for checking out materials. Classroom teachers will coordinate additional opportunities for student research.

Students are taught the proper care of books, and special attention should be given to ensuring the long life of library materials.  Overdue notices are periodically issued.  Parents or guardians will be responsible for lost or damaged items.  The library media specialist with the principal’s approval will set charges for damage or loss.  Such fees will be based on the age, cost, and condition of the item(s).

LIBRARY RULES
· Conversation or loud noises should not disrupt those working in the library.
· The library should be kept neat and clean.
· Books and other materials should be handled carefully and returned to the designated area for re-shelving by the library staff.
· Magazines, newspapers, and reference materials should be returned to shelves after use.
· Only school staff should move AV equipment.

30. LOCKERS

Lockers are provided for students in grades 4 -7.  Each student is responsible for keeping his assigned locker clean and orderly. There is a $10.00 fee for locker rental.

The student privilege of using a locker may be taken away for damage or misuse.  With reasonable suspicion (reasonable grounds to believe that property will be found which violates school regulations or may be harmful to the school or students) lockers may be searched by the school administration.

31. LOST and FOUND

Articles found in and around the school should be placed in the LOST and FOUND that will be located in the cafeteria.  Owners may claim their property by identifying it.  All clothing and other items remaining at the end of each semester will be donated or discarded.  

	-Parents are encouraged to see that their children's belongings are marked with their names.


32. MEDICATION

Medications will be administered at school following School Board Policy.  A copy of the policy, "Administering Medications to Students", (Policy JHCD), is available in the division wide handbook.  Questions regarding the policy should be directed to the principal.  Medication Authorization Forms available upon request.






33. MINUTE OF SILENCE

Effective July 1, 2000, schools are required to open the school day with a minute of silence.  The Code of Virginia, § 22.1-203 states:

In order that the right of every pupil to the free exercise of religion be guaranteed within the schools and that the freedom of each individual pupil be subject to the least possible pressure from the Commonwealth either to engage in, or to refrain from, religious observation on school grounds, the school board of each division shall establish the daily observance of one minute of silence in each classroom of the division.

During such one-minute period of silence, the teacher responsible for each classroom shall take care that all pupils remain seated and silent and make no distracting display to the end that each pupil may, in the exercise of his/her individual choice, meditate, pray, or engage in any other silent activity which does not interfere with, distract, or impede other pupils in the like exercise of individual choice.

The Code of Virginia (§22.1-202) now requires each School Board require the daily recitation of the Pledge of Allegiance in each classroom of the school division.  During the Pledge of Allegiance, students shall stand and recite the Pledge while facing the flag with their right hands over their hearts or in appropriate salute if in uniform; however, no student shall be compelled to recite the Pledge if he, his parent or legal guardian objects on religious, philosophical or other grounds to his participating in this exercise.  Students who are thus exempt from reciting the Pledge shall remain quietly standing or sitting at their desks while others recite the Pledge and shall make no display that disrupts or distracts others who are reciting the Pledge.

34. PARENT ORGANIZATION (Parent Teacher Organization - PTO)

The PTO committee will meet once a month.  The meetings will be held the second Monday of each month at 6:00 pm in the VES cafeteria.

PTO Committee Members: Volunteer Faculty and Staff
TBA – President
Erica Doyle – Treasurer

35. PARTIES

Classroom parties to celebrate a holiday or to recognize special accomplishments may be planned for students; however, their number should be limited.  Teachers will secure approval from the principal before planning or announcing a party.  

36. PHYSICAL EDUCATION

Students will participate in physical education classes.  If a child is to be excused from P.E. for one or two (1-2) days for health reasons, the school will accept a note from a parent/guardian.  If the excuse involves three (3) or more days, a doctor’s note is required.  

For safety, proper shoes should be worn for P.E.; sandals, slides, boots, hunting boots, and stocking feet are unacceptable.  Only tennis shoes should be worn in the gym, and they must be properly laced and tied.  Unacceptable shoes will result in the student sitting out of PE for the day.  

37. PROMOTION, RETENTION and REMEDIATION 

See BCPS policy IGA-R in appendix A for more information.

38. PROMOTION – SEVENTH GRADE

Seventh graders will have the opportunity to participate in a Seventh-grade promotion ceremony if they meet all requirements to be promoted to the eighth grade.





39. SCHOOL SPONSORED EVENTS

Students that are absent from school or check out early on the day of a school sponsored event may not participate in the school sponsored event.  Students must be present at least half the school day to participate.

40. SEARCH AND SEIZURE

To maintain order and discipline in the schools and to protect the health, safety and welfare of students and school personnel, school authorities may perform a search of a student or a student’s property under the circumstances outlined in BCPS policy JFG.  



41. SICKNESS AT SCHOOL

Parents/guardians will be called to pick up children who become ill at school.  Children that have recently been sick; parents/guardians should not send their children to school until they have been fever free for 24 hours.

42. SPECIAL EDUCATION SERVICES

The Bath County Public Schools offer a full range of special education services to students with disabilities.  Students are initially identified through the Child Study Team process, including screening and exploring alternatives within the classroom setting.  When problems persist, the school may follow with assessment and implementation of individual student plans.  Special education services must always be provided in the least restrictive environments.  Students with disabilities will be integrated into the regular school program to the maximum extent appropriate.  	

All children, within sixty (60) days of initial enrollment in a public school will be screened in the following areas to determine if formal assessment is indicated: 1) speech, voice, and language; 2) vision and hearing; and 3) fine and gross motor function.

The Child Study Team meets regularly to review records of those children referred through the screening process. The committee includes the school counselor, the school psychologist, the school principal or designee, the referring teacher/source, other teachers and specialists, as appropriate.

Action on referrals will be taken within 10 days.  Actions taken by the committee are documented in writing and referrals for formal assessment are made when necessary.

43. TEACHER QUALIFICATIONS

Parents may request information regarding the professional qualifications of your child’s classroom teacher.  This information will include the following: 
· whether the teacher has met state qualification and licensing criteria for the grade levels and subject areas in which the teacher provides instruction
· whether the teacher is teaching under emergency or other provisional status through which state qualification and licensing criteria have been waived
· the baccalaureate degree major of the teacher and any other graduate certification or degree held by the teacher, and the field of discipline of the certification or degree
· whether the child is provided services by paraprofessionals 

44. TELEPHONE and FAX

Students may not use the office telephone for personal calls except in an emergency and with staff permission.  Students may not receive telephone calls at school.  When it is necessary for a parent or guardian to communicate with their child(ren), please contact the school secretary.





45. TEXTBOOKS

There is no charge for textbooks.  Each student issued textbooks will be given a contract noting titles/numbers and the condition of each book.  Parents or guardians should notebook conditions, sign, and return the contract to school.  TEXTBOOKS ARE TO BE KEPT CLEAN AND HANDLED CAREFULLY. 
At the end of the school year, parents or guardians will be responsible for paying for damaged or lost books.  A schedule of textbook damage fees is listed below:


Bent Cover – $6						Lost Book – Cost of Replacement
Broken Binding – $6					Rebinding – $10
Damaged Corner (per corner) – $2				Torn Pages – $5
Excessive Writing – $5					Water Damage – Cost of Replacement

46. TITLE I PROGRAM 

Title I is a federally funded program that provides supplemental reading and/or math instruction to help students achieve reading comprehension, computation and/or problem-solving skills.  Emphasis is placed on early intervention.  Regular classroom teachers refer students who are experiencing difficulties to the program.  The students are screened and selected to participate on the basis of their classroom performance and diagnostic testing.  Participating students receive instruction from their regular classroom teacher and from a professional Title I teacher.  Instruction is correlated with county curricula and delivered through one-on-one or small group tutoring. 

Parents of selected students are notified and permission to deliver services is requested.  Parental involvement in the Title I program is encouraged through an annual parent meeting, parent workshops, newsletters, resource materials, progress reports, and volunteer opportunities.

47. TOBACCO-FREE SCHOOL

Use of tobacco products by staff, students and visitors is prohibited on school property.  See BCPS policy GBEC and KGC for more information.

48. TRANSPORTATION 

See the division wide handbook for more information.

49. VANDALISM and PROPERTY DAMAGE 

Efforts are continually made to maintain a safe, attractive, and instructionally appropriate school facility.  Students are expected to respect school property.  If a student accidentally damages something, he/she should immediately report it to a teacher or the school office.  See BCPS policy JFC-R for more information.

50. VISITORS

For the safety of students and staff and the protection of instructional time, ALL visitors, including parents or guardians, should use the main school entrance and report to the office upon arrival at school.  Visitors will be issued a badge before being allowed to visit classrooms or other areas of the building.  You must bring your driver’s license or identification to the school office. 

51. VOLUNTEERS 

Parents and other community members are encouraged to become active participants in school activities by providing, extending, and/or supporting educational opportunities for children, and serving on school and division committees.  Individuals who would like to become involved in the school program by sharing their time and talents should contact the school office.  The involvement of volunteers is an important component of a successful school.  Volunteers must fill out a volunteer form and be approved by the administration.

Another way to volunteer is to serve on an advisory committee.  Current advisory committees include Calendar, Career and Technical Education, Wellness (School Health Advisory/Concussion Management), Special Education, Technology.  Contact your school office if you wish to serve on an advisory committee. 
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All Staff Report @ 11:30 AM

Parent-Teacher Conferences (Progress Reports)

1:00-4:00 PM & 4:30-7:00 PM

MARCH (19 days)

12 EARLY RELEASE 12:30 PM
(If Delayed Opening-Becomes Full Day)
3rd Grading Period Ends (45 days)
Teacher Workday 1:00-3:30 pm
13-14 SCHOOLs CLOSED
20 Report Cards Sent Home

APRIL (19 days)
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22-23 Teacher Workday 8:15 am-3:30 pm
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TEACHER
SCHOOL PUPIL EARLY RELEASE INSERVICE/
DAYS HOLIDAYS DAYS WORKDAYS
AUGUST 17 0 0 4
SEPTEMBER 20 1 1 0
OCTOBER 22 1 1 1
NOVEMBER 16 5 0 0
DECEMBER 15 7 1 0
JANUARY 18 5 0 1
FEBRUARY 19 1 0 1
MARCH 19 2 1 0
APRIL 19 3 0 0
MAY 15 0 1 2
JUNE 0 0 0 0
180 25 5 9
Total Scheduled Days......... 189
Unscheduled Workdays..... 11
TOTAL CONTRACTED DAYS 200
PROGRESS
GRADING PERIOD ENDS NO. DAYS REPORTS REPORT CARDS
1° - October 10 45 September 9 October 17 *
2" — December 20 45 November 13 January 13
3"~ March 12 45 February 6 * March 20
4" — May 21 45 April 16 May 29
TOTAL 180 * Parent-Teacher Conferences
Bath County High School Millboro Elementary School Valley Elementary School
464 Charger Lane 411 Church Street 98 Panther Drive
Hot Springs, VA 24445 Millboro, VA 24460 Hot Springs, VA 24445
540-839-2431 540-997-5452 / 540-839-5804 540-839-5395

2/12/2024 12:38 PM
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				13		14		15		16		17		18		19						Teacher Workday  1:00-3:30 pm				13		14		15		16		17		18		19

				20		21		22		23		24		25		26				17		PUPIL HOLIDAY				20		21		22		23		24		25		26

				27		28		29		30		31								  		All Staff Report @ 11:30 AM				27		28		29		30						

																						Parent-Teacher Conferences (Report Cards)																

																						1:00-4:00 PM & 4:30-7:00 PM



				November 2024																NOVEMBER  (16 days)						May 2025																MAY  (15 days)								Background colors. The background color for the weekends and blank days are controlled using conditional formatting. To edit, select the cell(s) and go to Format > Conditional Formatting.

				Su		M		Tu		W		Th		F		Sa				13		Progress Reports Sent Home				Su		M		Tu		W		Th		F		Sa				21		EARLY RELEASE 12:30 PM

														1		2				25-29		FALL BREAK / SCHOOLs CLOSED												1		2		3						  (If Delayed Opening-Becomes Full Day)

				3		4		5		6		7		8		9				 						4		5		6		7		8		9		10						4th Grading Period Ends (45 days)

				10		11		12		13		14		15		16										11		12		13		14		15		16		17						LAST PUPIL DAY (180 days)

				17		18		19		20		21		22		23										18		19		20		21		22		23		24						Teacher Workday  1:00-3:30 pm

				24		25		26		27		28		29		30										25		26		27		28		29		30		31				22-23		Teacher Workday  8:15 am-3:30 pm

																																										26		MEMORIAL DAY / CLOSED

																																										29		Report Cards Sent Home



				December 2024																DECEMBER  (15 days)						June 2025																JUNE 								View the Print Area. To view the current print area, first view the Print Preview (Ctrl+P) then return to the Home tab. Or, go to View > Page Break Preview. The print area will become highlighted with a dashed line. To choose a new print area, select the cells you want to include and go to Page Layout > Print Area > Set Print Area.

				Su		M		Tu		W		Th		F		Sa				20		EARLY RELEASE 12:30 PM				Su		M		Tu		W		Th		F		Sa

				1		2		3		4		5		6		7						  (If Delayed Opening-Becomes Full Day)				1		2		3		4		5		6		7

				8		9		10		11		12		13		14						2nd Grading Period Ends (45 days)				8		9		10		11		12		13		14

				15		16		17		18		19		20		21						Teacher Workday  1:00-3:30 pm				15		16		17		18		19		20		21

				22		23		24		25		26		27		28				23-31		WINTER BREAK / SCHOOLs CLOSED				22		23		24		25		26		27		28

				29		30		31																		29		30										



				SCHOOL DAYS = 180   /   PUPIL HOLIDAYS = 25   /   EARLY RELEASES = 5   /   TEACHER INSERVICE-WORKDAYS = 9   /   UNSCHEDULED WORKDAYS = 11
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		BATH COUNTY PUBLIC SCHOOLS 2024-2025 DIVISION CALENDAR										Page 2

		SCHOOL BOARD APPROVED:  2/6/2024







						SCHOOL DAYS		PUPIL HOLIDAYS		EARLY RELEASE DAYS		TEACHER INSERVICE/ WORKDAYS

				AUGUST		17		0		0		4

				SEPTEMBER		20		1		1		0

				OCTOBER		22		1		1		1

				NOVEMBER		16		5		0		0

				DECEMBER		15		7		1		0

				JANUARY		18		5		0		1

				FEBRUARY		19		1		0		1

				MARCH		19		2		1		0

				APRIL		19		3		0		0

				MAY		15		0		1		2

				JUNE		0		0		0		0

						180		25		5		9



						Total Scheduled Days.………				189

						Unscheduled Workdays..…				11

						TOTAL CONTRACTED DAYS				200





				GRADING PERIOD ENDS				NO. DAYS		PROGRESS REPORTS		REPORT CARDS

				1st – October 10				45		September 9		October 17 *

				2nd – December 20				45		November 13		January 13

				3rd – March 12				45		February 6 *		March 20

				4th – May 21				45		April 16		May 29

				TOTAL				180		* Parent-Teacher Conferences



		Bath County High School				Millboro Elementary School				Valley Elementary School

		464 Charger Lane				411 Church Street				98 Panther Drive

		Hot Springs, VA  24445				Millboro, VA  24460				Hot Springs, VA  24445

		540-839-2431				540-997-5452   /   540-839-5804				540-839-5395
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